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1 Getting Started

This guide provides information for buyers and suppliers about using and personalizing SAP Fieldglass.

Here you can explore different settings and options in order to create an experience centered around your

preferences and business needs.

Use the Table of Contents and Search bar to locate helpful information about setup, customization, and

features within this guide.

Note that the options described in this guide are dependent on your company's configurations and your user

visibility options.

11 What's New in This Guide

A summary of recent changes to the Setting up and Managing your SAP Fieldglass Experience guide.

Updated Date

What's New

More Information

May 2023 Updated the Chat topic to include in- FGL-103721
formation about the 'All Suppliers' tab
availability for SOW Bids.
May 2023 Added the 'Worker Centric View' topic.  FGL-113998
November 2022 Added the 'Vertical Navigation' topic FGL-95657
and edited the 'Past Data' and 'Naviga-
tional Bars' topics.
November 2022 Added information about case manage- DOC-546
ment and follow ups.
November 2022 Updated the Chat topic to include ade- FGL-112308
scription of the 'Supplier Chat Respond
By Date' function.
May 2022 Updated color theme choices in My
Preferences topic.
May 2022 Added 'Downloading Multiple Archived
Documents to Your Browser' topic.
Welcome to SAP Fieldglass
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Updated Date What's New More Information

November 2021 Updated the Chat topic to indicate that
chat messages are now grouped by job
posting and work order.

Updated the Social Messages topic with
changes to the Social Messages tabs.

Updated the SOW Rules topic with
changes to the Can Supplier change
the amount prior to invoicing the
Schedule and Can Supplier change
the amount when marking the Event
as complete rules.

June 2021 This content has been updated with
changes from the June 2021 release.

November 2020 This content was updated with changes
from the November 2020 release.

July 2020 Initial publication to the SAP Help Por-
tal.

1.2 Your SAP Fieldglass Home Page

Familiarize yourself with the SAP Fieldglass Home page.

Once you've signed in to SAP Fieldglass, the Home page displays. You're prompted to take the Welcome Tour,
which gives an overview of the Home page and information about how to navigate it. The link to the Welcome
Tour appears by default. To remove it, select the "x" to the right of the link. You can still access the Welcome
Tour through the View help menu icon in the header bar.

Alink to the SAP Fieldglass Release Communication information displays under the Welcome Tour link. The
Release Communication document contains information about new features and enhancements for the most
current release. To remove it, select the "x" to the right of the link. You can still access the link through the View
help menu icon in the header bar.

Widgets

By default, various widgets are displayed on the Home page to provide easy access to other areas of the
application. These widgets, as well as several other widgets, can be hidden or displayed depending on your
needs.

Two prominent widgets, My Workers and My Statements of Work allow you to request a worker or create a
statement of work directly from the widgets. Once you create workers or statements of work, they're displayed
here with a color-coded box to reflect their state. States include Good, Warning, and Critical. A green box
indicates that the worker or statement of work is in a Good state, but may have pending items that require
attention. A yellow box indicates a Warning state and that pending items may require attention in the near
future. A red box indicates a Critical state and items currently require attention.

Welcome to SAP Fieldglass
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Menu Bars

Positioned at the top, the header bar gives you access to work items, messages, the feature switch, search,
settings, and different configurations based on your permissions. Below the header bar, the menu bar gives you
access to Home, which returns you to the Home page from anywhere in the application, as well as the View,
Create, Analytics menus, and the PMO Dashboard. Note that the menu bars display this way for the default Top
Navigation view. Changing your view to the Vertical Navigation option positions the menu bar on the left-hand
side of the screen. See Navigation [page 14] for more details.

1.2.1 My Workers Dashboard

The My Workers widget and dashboard show a summary of your workers.

When logging in to the SAP Fieldglass application with the default user interface option, the My Workers
widget displays on the Home page. Job postings and workers are divided into health states on the widget and
dashboard (Critical, Warning, and Good). Selecting a job posting from the widget (or a health state) takes you
to the My Workers dashboard. The dashboard contains all your job postings and workers on the left-hand side
of the screenin a list. Selecting an item from the list displays a preview. You can use the Search By field to
perform a search, filter by criticality, or use the Show Starred Items Only field to only display items that have
been starred. Additionally, directly from the widget, you can select + Request Worker to begin a job posting.

When you enable the Worker Centric user interface option (via the Feature Switch in the header bar), the My
Workers widget displays with theGo to Dashboard button, which leads you to the Worker Dashboard. The
Worker Centric Worker Dashboard provides a summary of all of your assigned workers. It also includes two
Advisor charts allowing you to quickly see key performance indicators about worker spend.

The information is separated into two sections. The top section includes three cards: Items to Complete, Total
Worker Spend for the Month, and Actual Spend by Month and Worker Count. The My Workers section at the
bottom lists all assigned workers individually by state (Critical, Warning, and Good) in either card or list view.
A red border indicates a Critical state and that items currently require attention. An orange border indicates a
Warning state and that pending items may require attention in the near future. A green border indicates that
the worker is in a Good state but may have pending items that require attention.

The Items to Complete card displays the items to be completed across all your assigned workers and separates
them by thresholds defined by your administrator. In order to help facilitate this process, contextual help is
available for this card. Selecting the View Items to Complete button opens additional details about the items
and allows you to act on items without navigating away from the page.

The Total Worker Spend for the Month report compares the actual spend to date with the committed spend for
the current month of all associated workers. The Actual Spend by Month and Worker Count chart shows the
actual spend by month and the worker count.

Selecting a worker in the My Workers section displays the Worker Details page.

1.2.2 My Statements of Work Dashboard

The My Statements of Work widget and dashboard show your statements of work.

When logging in to the SAP Fieldglass application, the default user interface is enabled. With this default option
enabled, the My Statements of Work widget displays on the Home page. Statements of work are divided into

Welcome to SAP Fieldglass
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health states (Critical, Warning, and Good) on the widget. Selecting a statement of work from the widget (or a
health state) takes you to the My Statements of Work dashboard. The dashboard contains all your statements
of work on the left-hand side of the screen in a list. Selecting a statement of work from the list displays a
preview. You can use the Search By field to perform a search, filter job postings by criticality, or use the Show
Starred Items Only field to only display job postings that have been starred. Additionally, directly from the
widget, you can select + Create SOW to directly create a statement of work.

When you enable the Worker Centric option (via the Feature Switch in the header bar) the My Statements
of Work widget displays with theGo to Dashboard button, which leads you to the My Statements of Work
Dashboard.

1.2.3 My Job Postings Dashboard

The My Job Postings widget and dashboard show a summary of your job postings.

When the Worker Centric user interface option is enabled (via the Feature Switch in the header bar), the My
Job Postings widget displays. Job postings are divided into health states (Critical, Warning, and Good) on the
widget. You can select the Request Worker button from the widget to directly start a Job Posting or select the
Go to Dashboard button to go to the My Job Postings dashboard.

The My Job Postings dashboard contains all your job postings on the left-hand side of the screen in a list.
Selecting a job posting from the list displays a preview of the job posting. You can use the Search By field to
perform a search, filter job postings by criticality, or use the Show Starred Items Only field to only display job
postings that have been starred.

1.2.4 Customizing Your Home Page

Customization Mode helps you arrange widgets on your Home page.

Select the Customization Mode wrench icon to begin arranging the Home page according to your preferences.

Arranging Widgets:

® You can turn widgets On or Off, move widgets on the page, or view additional information about a widget's
functions.

* To move a widget, hold down the | = Move Widget icon and drag it to the desired location. You can acquire
more widgets by turning them on or off in Customization Mode or on the My Preferences page.

Contextual Help

¢ Contextual help gives you further details about a widget's function. To access Contextual Help, select the
Contextual Help icon.

To exit Customization Mode, select Done.

Welcome to SAP Fieldglass
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1.3 Settings

Your Settings allow you to personalize your profile, set Home page and application preferences, and view an
organizational chart made up of users and workers in the SAP Fieldglass application.

Select the avatar or photo in the top right of the page to access the three menu options options under
Settings:

* My Profile

* My Preferences

¢ My Org Chart

1.3.1 My Profile

Customize your profile using the My Profile settings.

Select the photo or avatar in the top-right corner of your Home page and select My Profile under Settings.
In the My Profile tab, any of the places that display the Edit option allow you to edit the information in that
section.

* Name: Add or edit your general contact information in the section that contains your name.

¢ Account Information: You can change your password under Account Information. Further editing
of Account Information can only be done by an administrator or someone in a user role with the
administrative permission, User/Manage.

¢ Organizational Structure: Define or edit information for Default Legal Entity, Primary Business Unit,
Default Site, and Default Cost Center.

¢ Linked Accounts: Link other buyers and suppliers to your account or disable this functionality.
* Proxies: Add or manage your proxies.
* Delegates: Add or manage your delegates.

¢ Approvers & Supervisors: View your supervisors and signature authority.

Proxy

A proxy is a user who can take action on another user's work items, but does not inherit the other user's
visibility and permissions.

Proxies help ensure the workflow of documents, such as approval of time sheets, continues uninterrupted if

a user is unable to take action during a period of time. For example, if a user is out on leave, a proxy can be
established and the user’s work items are routed to the proxy for the time period selected. You can select a
proxy using the My Profile page. Additionally, if you have the Administrative Permission:Manage Users enabled,
you can also assign a proxy for a user. Proxies can be edited or removed at any time.

Proxies can be assigned for a specified date range. If a date range is not entered, the proxy is active
immediately and remains a proxy until removed.

Welcome to SAP Fieldglass
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To ensure that proxies have appropriate permissions to act on work items, users available to be selected as
proxies are limited to the following:

* Administrators
* Users within the same user role
* Users within an associated proxy role

When viewing work items, a proxy icon &8 displays for items that have been routed to you via the proxy feature.
You can also filter your list view to include proxy work items or not.

Assign a Proxy

When establishing a proxy, you can designate whether the proxy can approve all work items or just time sheets.
A user can have multiple proxies and users can be proxies for one another.

Select your photo or avatar in the top-right corner.

Select My Profile.

Under Proxies & Delegates, select Edit.

Under The following Users are your Proxy, select + Add Proxy.

Choose whether your proxy can approve All Work Items or just Time Sheets.
Select your proxy from the dropdown menu.

Select your Start Date and End Date.

Select Add.

0 N O oA W

You can view all your proxies in The following Users are your Proxy list under Proxies & Delegates.

Edit or Remove a Proxy

You can remove and edit yourself and other users from being proxies in the My Profile section under Proxies
& Delegates. If the user you're a proxy for is closed, the proxy association is removed and they're no longer
displayed in the Proxies section of the My Profile page.

* Under The following Users are you Proxy, select Edit to edit the proxy information, or Remove to remove
the proxy.

* Toremove yourself as a proxy, under You are the Proxy for the following Users select Remove.

Assign a Proxy to a User

Administrators and users in a role with the Administrative Permission: Manage Users enabled can assign a
proxy for a user.

1. Select your name in the upper right-hand corner of the page and select |- Admin Configuration j» User
» User. 4

Choose the Name link for the desired user.

Select Proxies in the left-hand menu.

Select Add Proxy.

Select the desired Work Items on which a proxy can act.

IS

Enter a Start Date and End Date if desired. If these dates are left blank, the selected user becomes a proxy
immediately and stays a proxy until removed.
7. Select Add.

Welcome to SAP Fieldglass
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Delegate

Delegates have the same visibility and permissions as the original user and can take action on another user's
work items, such as job postings, time sheets, and work orders.

Delegates are assigned and managed on a user's profile. You can assign your own delegates, or users with
permission to assign delegates can assign them for you. A single user can have multiple delegates and can be
assigned as a delegate for multiple users. Users who have not registered yet are not available to be selected as
delegates.

To set up the Delegate functionality, enable the Enable Delegate company configuration. When this feature
is enabled, all users can add delegates. All users can be selected as delegates regardless of associations,
permissions, or user roles.

The list of a user's delegates as well as a list of accounts who a user is the delegate for appears in the Proxies &
Delegates section of the My Profile page. You can access the My Profile page by selecting your photo or avatar
in the upper right-hand section of their SAP Fieldglass Home page, then My Profile. The list can be edited and
delegates can be added and removed as needed. You may remove yourself as a delegate for someone else, but
you can't add yourself as a delegate for another user.

Add or Remove Delegates

* From the My Profile page, select Edit next to the Proxies & Delegates section.

¢ |f desired, select the Set Period button to add start and end dates to newly added or existing delegates.
After the end date is reached, the delegate is removed from the list.

* Toadd a delegate, select + Add Delegate. To remove a delegate, select Remove next to the user's name.

Linked Accounts

The Linked Accounts list, accessible from your profile picture, displays a list of accounts you can immediately
switch to. Once a delegate has been assigned, the profile automatically displays in the Linked Accounts list.

Other accounts can be linked as well by navigating to | Settings » My Profile }» Linked Accounts. J

Act as a Delegate

To act as a delegate, select the account from the Linked Accounts list (the 58 delegate icon displays next to the
account name). This action automatically switches a user from their account, to the account for which they are
the delegate. To switch back, use the linked account list again.

When a delegate is logged into the original user’s account, the My Profile and My Preferences pages are locked
for editing for security reasons. Actions completed by a delegate appear in the System Audit Trail and in the
Audit Trail section of a document’s Lifecycle Tab with the original user's name followed by the delegate user’s
name in parentheses.

When accessing a user's account as a delegate, an error occurs if:

* The original user’s password has expired. For these cases, password resets can only be completed by
original users.

* The original user’s account has been deactivated.

Welcome to SAP Fieldglass
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1.3.2 My Preferences

The My Preferences tab contains Home page and applications settings, messaging options, and other default
choices.

Select the photo or avatar in the top-right corner of your Home page and select My Preferences under
Settings. In the My Preferences tab, any area that displays the Edit option allows you to edit information in
that section.

The information in the following sections can be edited:

Locale

Add or edit general information for items such as currency, time zone, language, date, calendar start day, time
format, and number format.

Home Page and Application Settings

* Color Theme: Choose from several options for the application's color theme: Quartz Light, Quartz Dark,
Morning Horizon, Company Branded, or High Contrast Black. The High Contrast Black option is designed
to help visually impaired users that have trouble seeing subtle color differences.

Buyer companies can request their own company-branded color theme from their SAP Fieldglass
representative. Once created, it can be applied to new buyer users, and existing buyer users can set their
personal color theme to the new company-branded theme at the user preference level.

* Landing Page upon Log In: Choose which page displays upon login.
* Home Page Items: Choose which pages you would like to see or hide on the Home page.
* Home Page Counts: Show or hide Statement of Work Counts and Show Worker Counts.

* Default Tab On Documents: Select whether you would like the Details or Summary tab to display on
documents. The Details tab gives specific information about the document and the Summary tab gives a
basic summary version.

* Reports and Charts: Expand report and chart information, or add a new report.

¢ Graphical View: Choose this option to enable a low-density view for pages in the contingent workflow, such
as the Job Posting preview modal and Job Posting Distribution tab.

¢ Work Items Cache: All of your work items are cached to reduce their performance impact, and you can use
the Refresh button in the Work Items Menu to manually refresh the list.

Messaging
Choose preferences for email format, email and system message notifications, and sending notification digests
and work item digests.

Interview/Meeting

Edit the default information for interviews or meetings, addresses, phone or video conference information,
meeting times and durations, and G Suite Email addresses.

Welcome to SAP Fieldglass
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1.3.3 My Org Chart

The My Org Chart link is a quick way to access the organizational chart, a graphical representation of
employees and non-employees in one view.

The organizational chart shows you basic information about work-related individuals who are users or workers
in the SAP Fieldglass application. It shows how they relate to each other in a hierarchical format.

Related Information

Organizational Chart [page 12]
Viewing the Organizational Chart [page 13]

Organizational Chart

Provides buyers and workers with an interactive graphical representation of both employees and non-
employees who are users or workers in the SAP Fieldglass application in one view.

The organizational chart provides basic information including the SAP Fieldglass reporting hierarchy. For buyer
users, the primary supervisor of the user is used; for workers, the worker owner is used. The chart shows two
levels above the person, the peer group, and one level below.

The Enable Organizational Chart company configuration must be enabled before you can view organizational
charts. When the configuration is enabled, users in roles with the administrative permission |+ Organization
Chart » View J have access to the My Org Chart link from the Settings menu.

Find Similar People, a feature that allows buyers to find workers with similar skills, can also be accessed from
the organizational chart.

Related Information

Viewing the Organizational Chart [page 13]
Find Similar People [page 17]
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Viewing the Organizational Chart

The organizational chart uses the logged in user as the starting point and displays two levels above the user,
the user's peers, and the user's direct reports.

Organizational Chart Legend

Legend

E Employee
Temp
m Direct Hire
B Statement of Work
E Profile Worker

See the organizational chart legend to determine the types of individuals shown in the organizational chart.

Organizational Chart Options

Each person in the organizational chart has an Options link. Selecting Options gives you access to the Go
to Details and Find Similar People options. When you select Go to Details, if you have visibility, the Details
page for the user or worker is displayed. When you select the Find Similar People option, you are able to
explore workers and buyer users who have similar skills. This option only displays if the buyer uses job code
functionality and the buyer user or worker has been assigned a job code.

Masterson, Collin Pk
Accountant

g

Go to Details

Peterson, Je

Accountant | iy Similar People

Uptions \QD/
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2 Working with SAP Fieldglass

Learn how to streamline your experience by searching, navigating, and operating different parts of the
application.

This section contains information about features that help you to organize daily activities, maneuver through
the application, and search for individuals or pinpoint important documents. These areas include (but are not
limited to):

* Navigational Bars: Two menu bars give you quick access to other parts of the application.

¢ PMO Dashboard: Easily manage day-to-day items.

* Search: Use various search features like the People Search or Global Search to locate people or
documents.

* Social Messages: Communicate or record information about the workflow of items.

¢ Organizational Chart: Delve into an interactive graphical chart of users or workers in the SAP Fieldglass
application.

2.1 Feature Switch

The Feature Switch provides user interface options.

The Feature Switch is located on the header bar. Selecting the View Feature Switch icon displays a menu of
select user interface features that you can toggle on and off. These features can include, for example, new
interface options or layouts. In future releases, these may become standard parts of the interface.

2.2 Navigation

There are two options for navigating the SAP Fieldglass application.

The SAP Fieldglass application's user interface can be viewed using the Top Navigation option or the Vertical
Navigation option. The Top Navigation option is enabled by default. In order to enable the Vertical Navigation
option, navigate to the Feature Switch in the header bar and select Vertical Navigation. To return to the Top
Navigation option, simply deselect the Vertical Navigation option.

Top Navigation

The Top Navigation option displays two navigational bars located at the top of the Home page, the header bar
and the menu bar. Even when navigating to other pages, these bars are permanently positioned at the top.

Welcome to SAP Fieldglass
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The header bar contains the Search bar, Web Assistant, Feature Switch, Work Iltems menu, Message Center,
Admin Configuration, and Help icon (some of these items may not display if you don't have the proper
permissions). Settings are found by selecting your photo or avatar. The Feature Switch displays a menu of
select user interface features that you can toggle on and off. These features can include, for example, new
interface options or layouts. In future releases, these may become standard parts of the interface.

The menu bar, located directly underneath the header bar, contains:

* Home: Returns you to the Home page.

* View: Leads you to view the pages nested within My Items, Planning, Contingent Labor, Services, Worker,
Payments, and Supplier.

¢ Create: Allows you to create various items such as a Job Posting or Statement of Work.
¢ Analytics: Gives you access to report information.

¢ PMO Dashboard: Allows you to manage day-to-day tactical items within SAP Fieldglass that may require
action.

Vertical Navigation

The Vertical Navigation option provides an alternate way to navigate the SAP Fieldglass application, using
a convenient side panel to house menu items. All categories and modules are displayed in a panel on the
left-hand side of the application's Home page.

The selectable categories are displayed on the side panel with corresponding icons. When a category on the
panel is selected, it expands to show its respective modules in a list. When you select a module from that list,
you're directed to that module's default page.

The Create button opens the Create menu, which enables quick creation of items such as job postings,
statements of work, reports, and more.

The Admin menu is accessible through the Admin button located on the bottom of the side panel.

The Help menu is available through the Help button on the bottom of the side panel and expands to show
support options.

2.3 Search Tools

The SAP Fieldglass application provides multiple ways to perform customized searches.
Use the following search features to locate documents, users, records, and more:

* Global Search
* Advanced Search
* People Search

Welcome to SAP Fieldglass
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2.3.1 Global Search

Quickly search from the Home page using the Global Search bar.

The Global Search functionality is always available from the header bar in the application. You can search by
any text or ID; however it does not render results based on geographical location as it does in Advanced Search.

To use Global Search, in the header bar on the Home page, place cursor inside the search bar. Enter a
document ID number or any text you would like to search. The search results display either the document you
searched for or a list of results.

Search by 1D or text

2.3.2 Search People

The People view allows you to search for people in one list, view their contact details, and access the
organizational chart.

Throughout the SAP Fieldglass workflow, individuals acquire roles representing their status in the work life
cycle. For example, workers begin their life cycle as job seekers, move to work orders, and finally become
workers. The People View is a consolidated list of buyer users, contingent workers, SOW workers, and profile
workers. Search results display individuals in one list, regardless of their status in the workflow, and present the
most current role.

Setup

To use the People view, the Use People View company configuration must be enabled and the Search People
widget shown. If Use People View is enabled, companies who want to exclude buyers in the People view can
select the Exclude Users from People View sub-configuration. When this is enabled, only workers are included
in the People view.

Usage

The Search People widget uses a “begins with” search that returns people that begin with the search word
entered. For example, typing Jose would find people with the name Jose Rodriguez or people who work at the
buyer’'s Joseph City site. It would not return results that contain people with names formatted like Rodriguez,
Jose.

The People view returns people that match the search criteria and includes associated documents that match
the person's name. It does not show workers, SOW workers, or profile workers that have been Closed. If
however, a Closed individual was open within the selected time period, they are in that case shown. Closed
work orders and SOW work orders don't appear.

In the case of Buyers, only active users are shown (including users flagged as MSP users). Buyers can be
excluded from the People view when the Exclude Users from People View company sub-configuration is
enabled.
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Viewing Search Results

For each worker, the People view displays the latest record associated to the worker. For example, for Temp
workers, SAP Fieldglass displays the Job Seeker Detail for the worker if a work order hasn't been created. If a
work order has been created, the work order displays. Similarly, if searching for a job seeker by ID, if a worker
record exists, the worker record is returned in the search results. Select Go to Details to view more information
on the person.

Selecting a person's photo in the People view displays their contact card. The contact card displays contact
information for the person, such as email address, phone number, time zone, and the View Organizational
Charticon.

i Note

In order for the View Organizational Chart icon to appear on the person's contact card, the person must be
a worker.

Search People Widget

You can search for individuals in the Search People widget or the People view by name or keyword:

1. Choose the Search icon in the Search People widget to be directed to the People view. Alternatively,
perform a search directly in the widget using a name or keyword.

Enter your search criteria in the People view, under Keyword.
Enter the desired information in the filter fields and choose Apply Filters to further customize your search.
Locate the individual you searched for in the search results.

ok~ W

Select Go to Details to view a complete list of details about the person. You can also select the person's
photo to see their contact card for general information.

2.3.3 Find Similar People

The Find Similar People feature allows buyers to look at all workers to see which workers have similar skills.
This option is only available if the buyer company is using job codes.

Buyers can view similar people including employees, temps, profile workers, direct hires, and SOW workers.
This allows them to find others with similar skills.

Find Similar People Modal

The Find Similar People modal displays users and workers with the same job code as the selected person.

When viewing the list, note that only active users and direct hires display in the list, while closed users don't.
Temp and SOW workers display when they are active during the date range selected.

From the Find Similar People modal, you can select the name to open the organizational chart for the
individual, or select the Details link to open the individual's user profile or worker summary.
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Find Similar People Usage

You can access the Find Similar People modal from a variety of areas in the application. If a buyer company is
not using job codes, the Find Similar People option is not displayed. The Find Similar People feature is available
in the following areas:

* Organizational Chart: Select the Options link on a person in the organizational chart and choose the Find
Similar People link.

&
® Users List: From the Users list view, select '&l Find Similar People next to the user's name in the list.

[ |
* Job Posting Template: From the Job Posting Templates list view, select 'q Find Similar People next to

the user's name in the list.
* Job Posting: From a job posting, select the Find Similar People option from the Actions menu.

* Worker: From the worker record, select the Find Similar People option from the Actions menu.

2.4 Working with List Views

List Views display items or search results as a list of entries.

Different filtering options display to help you customize the items in the list. You can filter using several options
including time period, group, status, location, and view, among others. You can also enter specific information
to search by name, ID, supplier, and more depending on the specific list.

The View More Items menu, located in the top right-hand side of the list view contains the following options:

* Pin to Home Page: Selecting this option pin the list view to your home page.

* Configure List Columns: Selecting this option allows you to check the fields you want to display in your
list view. Once you've checked your preferred fields, select Update. The unchecked fields are removed from
your list view.

¢ View Past Data: Selecting this option and configuring dates allows you to see data for that list view from
the past.

¢ View Archive Data: Selecting this option allows you to see archived data for that list view.

2.4.1 Past & Archive Data

You can access data from past time intervals using the Past Data functionality.

The Past Data functionality automatically moves documents that have aged out of general list views and into
Past Data list views in order to declutter general list views and maintain organization. Note that you lose
visibility into aged documents unless you view them in the corresponding Past Data list view.

To access Past Data, navigate to the Admin menu by selecting the View Administration Menu icon in the
header bar and choose Past & Archive Data under the Past Data section. Select a module from the dropdown
menu. On the Past Data page for the selected module, enter the desired time period in the past, along with any
other information you would like to filter by, and select Apply Filters. Alternatively, you can access Past Data
directly from a list view by selecting the View More Items menu and choosing View Past Data.
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If you select the Worker module for Past Data and your company has uploaded data with the Historical Worker
Upload or Historical Time Expense Upload, the Historical Worker list view tab displays on the Past: Workers
list view.

Unless an exception occurs, documents move into Past Data list views at the following times:

* Closed items and paid invoices move into Past Data after 7 days.
* Approved invoices move into Past Data after 45 days.

* Approved expense sheets and time sheets move into Past Data after 90 days.

2.4.2 View Workflow

You can access a workflow diagram using the View Workflow functionality.

The View Workflow functionality helps users understand the progress of items based on the status of each
work order or work order revision. You can hover over each step within the workflow to display the next step
action within the workflow. While all steps are displayed in the workflow, some steps may not be applicable
based on your company setup.

To access a workflow diagram from a list view, select the View More Items menu and choose View Workflow.

i Note

This option is currently only available on the Work Order list view page.
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3 Pinning Links

Pinning links allows buyers and suppliers to create links on Create and List View pages for all admin objects and
most documents, providing one-click access from the Pinned Links widget on the Home page.

Pin a Link

1. Topinalink, navigate to a page, and select the View More Items menu. From the menu, choose Pin to
Home Page. The page is then added in the Pinned Links widget on the Home page.

&7 Pinto Home Page
2, Configure your list views

(‘:‘5 View Past Data

2. Tounpinalink, select the “x" on the Pinned Links widget on the Home page. Alternatively, navigate to the
pinned page, and select Unpin from Home Page from the View More ltems menu.
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4 Social Messages

The SAP Fieldglass Social Messages features provide multiple ways for users to record information and
communicate regarding the workflow and management of documents.

When enabled, the Social Messages features are available for use on documents such as job postings,
statements of work, and work orders in the contingent and services modules.

The following features are included in the Social Messages package:

¢ Chat: This feature allows you to create chat logs related to documents and Candidate Portal Applicants.

* Reminders: This feature allows you to create reminders flagged with dates. The company configuration
setting for Reminders is Enable Reminder.

¢ Annotations: This feature allows you to capture private or public notes related to documents. The
company configuration settings for Annotations are Enable Annotations (Contingent) and Enable
Annotations (Services).

Optional Messaging Available

Default messages are available to be enabled or customized in the Messaging section of the Admin menu.

* Askan Expert: Chat Buyer (Contingent) and Chat Buyer (Services) modules
¢ Chat: Chat Buyer, Chat Buyer FCP Person (Contingent), and Chat Supplier modules
* Reminder: Reminder module

Usage

Individuals with appropriate user role permissions can access features by selecting the Social Messages icon
at the top of documents. Each feature that is configured displays as a tab in Social Messages when available
for use. Each tab displays the total number of items for that feature next to the tab title. In addition to

Social Messages, the message center, list views, work items, and Home page widgets also provide options for
managing social messages communications.

The features allow you to access modal windows where you can create, view, edit, and remove communications
as needed. If annotations, reminders, or chats exist for a document, a blue dot appears on the tab. Tabs

not appearing in Social Messages indicate that they are either not enabled or not available for the item or
document.
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4.1 Annotations

Annotations are used to capture private notes, create public notations, or review public notations on a variety
of documents to which users have access to in SAP Fieldglass.

Access annotations directly from the documents or View menu. Note that buyer-created annotations are not
visible to suppliers and supplier-created annotations are not visible to buyers.

¢ Create Annotations: To create an annotation on a document, select the Social Messages icon and choose
the Annotations tab. Depending on your visibility, options for Only Me, Program Office, and My Company
display and allow you to choose the annotation audience. Enter the annotation information, and choose
Save.

* Manage Annotations: With the correct permissions, you can view, submit, manage, edit, or remove
annotations from yourself and others. Annotations can be managed from through Social Messages on
documents or from the Annotation List page.

The following table displays the user role settings that can be enabled to use Annotations:

User Role Settings Options

Annotation (Contingent) Options are View, Submit, and Manage Other’s
) ) Annotations. To edit or remove annotations posted by oth-
Annotation (Services) ) ]
ers, the Manage Other’'s Annotations option must be ena-

bled.

4.2 Chat

The Chat feature is used to initiate communication with buyers or suppliers and allows anyone with document
visibility and chat permission to see associated chats.

Chats are visible immediately and can be accessed directly from various documents. Buyers can initiate
chats with suppliers as well as Candidate Portal applicants, while suppliers can initiate chats with buyers and
suppliers.

Initiate a Chat

¢ Toinitiate a chat on a document, select the Social Messages icon and choose the Chat tab. Select My
Company to share the chat with users in your company with the appropriate permissions.

i Note

Chat messages in all modules are limited to 4000 characters.

* Saved chats appear in the message center and on related documents.
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Initiate Chats with Suppliers

¢ Toinitiate a chat with all suppliers on a document, select the Social Messages icon and choose the Chat
tab. Select All Suppliers to initiate a chat with all suppliers associated with the document. Select Supplier
to select a single supplier from a list of suppliers associated with the document.

* Chats can be initiated with suppliers on records that have associated suppliers and aren't in Draft status.
For example, a job posting that has been distributed would allow for chat messages to be sent to suppliers.
When a chat is initiated, the All Suppliers and Supplier tabs display in the Chat modal window.

i Note

If Chats between suppliers for SOW Bids have been disabled, the All Suppliers tab isn't visible.

Manage Chats

You can view, edit, and remove chat messages. Chat messages can be viewed through Social Messages or the
message center. You can also respond to a chat message received via email.

To ensure full transparency and fair competition for all suppliers, buyers can optionally enter a chat cut-off date
and time on an SOW bid. Once enabled, suppliers can ask a buyer questions about the SOW bid using the Chat
function before the cut-off date and time. If used, the cut-off date and time display at the top of the Chat page
for the SOW bid. Once the chat cut-off date has passed, suppliers can no longer edit or remove existing chats
or save new chats; however, they can still use the Chat feature to view all chat messages.

Considerations

Chat messages are grouped and visible only to individuals who can view a related job posting or work order.
Posted chats for job postings and job seekers are grouped and displayed on job posting and job seeker
documents; posted chats for work orders, work order revisions, and workers are grouped and displayed on the
work order, work order revision, and worker documents. When entering a message for a specific item, it's best
practice to reference the document ID, name, or other identifying information.

Suppliers who have received a job posting can be included in chats. When a job posting is distributed to
subsequent levels in the distribution group, the new suppliers are able to view all previous chats that occurred
before the job posting was distributed to them.

The following table displays the user role settings that can be enabled to use Chat:

User Role Settings Options
Chat Buyer (Contingent) Options are View, Submit, and Manage Other’s messages.
Chat Buyer Supplier (Contingent) To edit or remove chats posted by others, the Manage

Other’ ti tb bled.
Chat Buyer Candidate Portal Person (Contingent) er's messages option mustbe enable

Chat Buyer (Services)

Chat Buyer Supplier (Services)
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4.3 Reminders

The Reminders feature enables buyers to create reminders related to documents for themselves or for other
users. Reminders create work items and they can be immediate or date driven.

Reminders are created and viewed from the Reminder List page or from various documents:

With the appropriate permissions, you can create a reminder using the following steps:

Select the Social Messages icon.

Choose the Reminders tab.

Select Create Reminder.

In the Description field, enter the information for the reminder.

In the Remind On field, select the date SAP Fieldglass should send the reminder.
Select yourself or another user as the Recipient.

Choose Submit.

N O s ®N e

i Note

The document ID populates automatically in the Attach to Document ID field. If desired, it can be removed
or updated with a different document ID. If a different document ID is entered, the reminder is visible on
that document.

Manage Reminders from the Work Items List

You can edit, remove, or mark reminders as complete. Additionally, you can manage reminders other users
created from Social Messages, reminder page, or the work items list.

Reminders display in your work items list and can be viewed and marked complete using the Mark as
Complete link.

When a reminder is created for you by another user, a message is generated. The message can be viewed and
the reminder can be marked complete in the message center. Dated reminders appear in the message center
on the due date and they cannot be removed until they are marked complete.

Manage Reminders from the Reminder List

You can create, view, edit, and remove reminders from the Reminders page. Reminders that you create for
yourself can be viewed, edited, and removed from the list. Reminders that were created for you by others can
also be viewed.

To access the Reminders list, select |» View » Reminders. J

If the logged in user is the reminder recipient, a Complete link displays in the Action column. Select Complete
to mark the reminder complete.

Incomplete reminders and reminders that have been marked complete display in the list until the reminder is
removed. The list can be filtered and sorted. You can remove any reminders that you have created, whether for
yourself or for another user.

Reminders can be edited or removed using the Edit link. Removing a reminder removes it from the Reminder
list and from the related document. Reminders cannot be marked complete from the Reminder list.

New reminders can be created using the Create Reminder button on the Reminders list.
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The following table displays the user role settings that can be enabled to use Reminders:

User Role Settings Options

Reminder Options are View, Submit, and Create for Other Users.

To create reminders for others, the Create for Other Users
option must be enabled.

4.4 Social Messages Management Tools

The Social Messages features can be managed in multiple ways depending on user role permissions and
document associations.

The following tools are available to manage the social messages features:

Social Messages Button

When viewing a document, use the =] social messages button to view and manage annotations, chats, and
reminders related to the document.
Message Center

Messages related to social messages features are used to notify users about communications that need their
attention. These communications can be viewed and managed in the message center. Note that removing
messages from the message center does not remove the communication from the related documents.

List Views

Social Messages features Reminders, Annotations, and Chat items and display in the My ltems section of the
View menu. Select an item from the menu to access the list view page. Actions that can be performed in list
views vary for each feature.

Home Page Widgets

When the Starred Items widget is selected to display on the Home page, a list of starred items displays with
links to starred documents. Select the link to access the document from the Home page.

When the Open Job Postings widget is selected to display on the Home page, messages and chats related to
job postings in the list can be viewed and managed.
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5 Starring

Starring allows users to create bookmarks for items and documents, making them easy to access from the
Starred Items list.

You can star documents for yourself or for other users. Starring is available to buyers and suppliers, however,
buyers can only star items for other buyer users and suppliers can only star items for other supplier users. All
users can star items for themselves, however only users with the user role permission Starring: Star for Other
Users can star items for another user.

Star an Item

1. To star anitem, navigate to the item and select the Starred icon.

2. Select Star for Me to star an item for yourself. When an item is starred, the Starred icon appears shaded.

3. Tostar anitem for another user, select Star for Someone Else. Note that when an item is starred for a user
by someone else, a message is generated and can be viewed in the message center or received via email.

4. Select a Recipient. If the recipient you selected doesn't have access to the item, a warning message is
displayed and the itemisn't starred.

Manage Starred Iltems

You can view starred items using the Starred Items list under |+ View » Starred. J

Stars can be viewed and removed using the Starred icon. To remove a star, select the Starred icon and select
Unstar for Me. The star is automatically removed and no longer appears gold. Alternately, navigate to the
Starred Items list view and select the Starred icon to remove it as a starred item. You can also select Star for
Someone Else to star the item for another recipient.

You can filter by items starred as favorites on the My Workers and My Statements of Work dashboards using
the Show Starred Items Only toggle.

These are the user role settings that can be enabled to use Starring:

User Role Settings Options

None There are no user role settings required for users to star
items for themselves. However, to star items for other users,
the Star for Other Users option must be enabled.
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6 Ask an Expert

The Ask an Expert feature enables buyers to ask other buyers questions related to job postings and statements
of work and is available when creating documents.

Users who are flagged as experts receive the questions as a message in their message center or via email.
From there, they can respond or forward the question to another user. Note that Ask an Expert is not available
when you create a statement of work from an SOW Bid.

Submit a Question

The Ask an Expert feature appears at the top of the Create Job Posting page and the Create Statement of
Work page.

¢ Click the Ask Question button to submit a question.

¢ Once aquestion is submitted, the Ask Another Question button appears on the page. Responses are
received and communication can be continued using the message center.

i Note

Note: The Ask an Expert feature is only available on the first step of the job posting creation process and
the statement of work creation process.

Customize Ask an Expert Text

The default text that appears with the Ask an Expert feature can be customized. Contact your SAP Fieldglass
representative for help.

Respond to a Question

Questions are automatically routed to users with the enabled settings. These recipients can respond or
forward questions using the message center. Additionally, recipients whose messaging preferences indicate
they receive Question type messages in email format can respond to questions by replying to the email. While
certain conditions must be met for a user to receive the initial questions, when a question is forwarded, there
are no restrictions. Recipients can forward Ask an Expert message they receive to any buyer in the company
from the message center.

Review Responses

Responses to questions appear with the subject displayed as Reply to Question posted. When a user responds
to a question, all other users who received the original question also receive the response. You can respond to a
question from the message center or by replying to the email.

The following table displays the user role settings that can be enabled to use Ask an Expert:

User Role Settings Details

If the Submit setting is not enabled, you cannot use this

Ask an Expert - Chat Buyer (Contingent): Submit
feature.

Ask an Expert - Chat Buyer (Services): Submit
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User Role Settings Details

User will receive Ask an Expert questions This setting must be enabled by an administrator in order
for users to receive and respond to questions. Note that
questions are only sent to experts that have visibility to the
primary business unit of the user asking the question.
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7 PMO Dashboard

The PMO Dashboard allows authorized users to manage day-to-day tactical items within SAP Fieldglass that
may require action. Follow up and completion of these work items ensures that the workflow continues with
minimal interruptions. Use of this tool can immediately improve the efficiency of the program.

The data displayed when a user accesses the PMO Dashboard is based on the business unit, site, and cost
center associations of the user. The dashboard includes two groups: Critical and Warning, and the items that
appear in each are based on the PMO Dashboard Threshold settings. Thresholds are set to determine the
amount of time that should pass before an item that requires action triggers a warning and then becomes
critical if no action is taken.

A few steps are required to implement the PMO Dashboard. Additional setup options are also available to
ensure the desired use of this feature.

Required Setup
Required Setup Description
Enable the PMO Dashboard The PMO Dashboard company configuration option must be enabled before users can be

company configuration option.  given access to the dashboard. When enabled, Thresholds - PMO Dashboard is an option
in the Workflow section of the Admin menu.

Enable the PMO Dashboard When the PMO Dashboard company configuration option is enabled, PMO Dashboard
user profile feature option. displays as an option in the Feature Access section on a user's profile. Enable this option
to allow the user access to the PMO Dashboard.

Establish PMO Dashboard PMO Dashboard Thresholds are used to determine the items that display on the PMO
Thresholds. Dashboard and to establish warning and critical levels for those items. Threshold settings
are not enabled by default.

Optional Setup

Optional Setup Description

Enable the PMO Dashboard user Enable the PMO Dashboard user role permissions for users who will need to establish
role permissions. PMO Dashboard thresholds.

In order to establish the necessary thresholds that populate the PMO Dashboard with
information, users must be an Administrator or in a user role with the Administrative
Permissions Thresholds- PMO Dashboard: View and Manage enabled.

Enable PMO Dashboard mes- Default PMO Dashboard messages are available and can be enabled or customized in the
Sages. Thresholds - PMO Dashboard module in |- Admin * Messaging. 3
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Related Information

Thresholds - PMO Dashboard [page 30]
Using the PMO Dashboard [page 30]

71 Thresholds - PMO Dashboard

In order for items to appear in the PMO Dashboard, thresholds must be enabled and values must be entered.

PMO Dashboard Thresholds are used to determine the items that display on the PMO Dashboard and to
establish warning and critical levels for those items. PMO Dashboard Thresholds also determine when critical
and warning icons display for items in SAP Fieldglass, such as activity items and offboarding activity items and
worker items in the My Workers Dashboard.

Administrators and users with appropriate administrative permissions can establish PMO Dashboard
Thresholds in the Workflow section of the Admin menu. Select Edit to enter new thresholds or update existing
settings.

For the thresholds you wish to capture on the PMO Dashboard, enter numeric values for the Critical and
Warning columns. Depending on the module, thresholds are set based on number of days or a percentage.

For example, a threshold may be set to include workers nearing their end date on the PMO Dashboard. The
Warning threshold may be set at 14 days and the Critical threshold may be set at 7 days. Workers with an end
date between 14 and 8 days away from the current date will be listed in the warning list, and workers whose end
date is within 7 days of the current date will be in the critical list.

i Note

If enabled, some thresholds display in the PMO Dashboard immediately as critical items, such as time
sheets in Approval Paused status. The Critical threshold value for these items is set to Instantly and
cannot be changed. Warning threshold settings do not apply.

Related Information

PMO Dashboard [page 29]

7.2 Using the PMO Dashboard

You can use the PMO Dashboard to view a summary of items approaching threshold deadlines and filter the
information you'd like displayed.

You can access the PMO Dashboard by selecting it from the menu bar on the Home page in the application.
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Information displays in tiles for each module and each tile displays the count of items that meet the defined
threshold values that have not been acted upon in Warning (yellow) and Critical (red) status. The Total on
each tile represents the sum of all items that are in statuses for which a PMO Dashboard threshold can be
configured. (It does not reflect the number of items for that module that actually meet the thresholds.)

Select a tile to open a summary of items requiring action (number of items per threshold). Choose an
individual threshold to open a list view of items requiring action.

Worker

213 ©
Total 13

Items Requiring Action 0,

Waorker Nearing Billable

Hours Limit 13
Total 13
ltems Not Addressed 13

In order to assist in addressing these items,
you may need to send a note or email.

Using Filters

You can filter the PMO Dashboard results by using the filters at the top of the page. Use the Show More Filters
link at the top of the page to reveal the full list of filters. Selecting Show Less Filters hides filters to free up

space on the page.

When you are finished making filter selections, select Search to display the search results.

Filter

Description

All, My Group, My Own

These filters display for all users, but only display results you are permitted to see.
For example, selecting All only displays your items if you are restricted to visibility
to your items only.

Labor Type

Use to limit results to items that are associated to particular labor type(s).

Cost Center, Site, Business Unit, Sup-
plier

By default, all items are shown. Choose Select to limit results to items that are
related to particular cost centers, sites, business units, and/or suppliers.
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Filter Description

Document Type Choose to display items for Contingent, Services, or All document types. For
example, choosing Services hides thresholds for job postings.

Only show items requiring action Setting this filter to Yes hides tiles that have no thresholds for both critical and
warning.

All tiles display if this filter is set to No. Tiles with no thresholds display zero

counts.

Document Type filters are Contingent, Services, and All.

Turning Tiles On and Off

You can customize which tiles display when you view the PMO Dashboard. As members of the Program Office
may have different responsibilities, everyone may not need to see all available modules. This feature lets you
suppress any modules that you do not want displayed on the dashboard.

To turn tiles on and off, select the wrench icon at the top of the PMO Dashboard.
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8 Support Tools

Use the support tools in the application to learn about new features or upload attachments.
Support tools include:

* Release Communication Document
* Product Documentation on the SAP Help Portal

* Reference Library

8.1 Customer Support Help Center for SAP Fieldglass

A harmonized Help Center customer support experience is available to SAP Fieldglass users that includes an
enhanced case submission experience, as well as access to a variety of support documentation to allow users
to quickly resolve their inquiries.

This support feature provides users with easy access to customer self-service assistance when issues arise
such as forgotten signin credentials, unresolved warnings or errors, unexpected system results, or general
process support information. The Help Center includes a variety of options to help users locate information
and tools for immediate assistance.

* Access knowledge base support content such as FAQs and product documentation.
* Interact with Guided Assistance to help you find answers and solutions to issues.

Access to the Help Center

The SAP Fieldglass Help Center is available to buyer users, all worker types, Candidate Portal account users,
supplier users, and PMO users. Options to open the Help Center are available in the following areas:

* Onthe Sign In page, select the Support icon.

* From within the application, select the Contact Us option in the Help menu (?).

* Email messages and message templates containing default text include the SAP Fieldglass Help Center
link.

Help Center Content by User Type

Access to content and options within the Help Center is based on user role (buyer, PMO user, supplier, worker)
within the application. Personas are based on a user's SAP Fieldglass signin credentials. This allows us to
customize the available content and options to improve the user experience.

When users access the Help Center from the SAP Fieldglass application, the following personas are used to
provide the appropriate user experience:

* FGbuyer - general buyer users and buyer administrators

* FGsupplier - supplier users and supplier administrators

* FGworker - workers and Candidate Portal users
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¢ FGPMO - PMO users and buyer administrators

8.1.1 Using the SAP Fieldglass Help Center

The SAP Fieldglass Help Center provides a personalized experience based on your role in the application
(buyer, supplier, worker, PMO).

If you are signed in to the SAP Fieldglass application, you'll authenticate into the Help Center using the role to
which you are assigned in the application. If you access the Help Center from the SAP Fieldglass sign in page,
you'll first need to select your role.

saprieldglass |\, Help Center

Help is on the way. Select a role that describes you.

A A

Warker Supplier

external, contract worker staﬁ'mg agency, vendor user

A A

Buyer Program Management Office
hiring manager, permanent employee of client company administrator, managed
client company service provider

Select Role

When the Help Center opens, the Home tab displays where you can search for information or browse through a
list of recommended content from our knowledge base based on your role.
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SAP Help Center Home

Home ning
How can we help you?
Try “cancel order”, “emall notifications”, “user authorization™
Topics we recommend for you
Haw do llinveice on a cloded SOWT
SON i in Closed S181UE DU furthey imdicing is NeCesEary It IS pOsSible 10 invoie If Allow Furtner Invoicing s been configured
Locate the SOW Click Actions > Manage Invoicing Review the value for Allow Further Invalcing When 2 is set 1o Yes, the SOW 9
does not need to be..
FAD
L2t Wodk - Bbegen
Haow do | update my supplier nama?
The name on my supplier account s inconmect Cur supplier name has legally changed Aztive supplier sdministrators can request
the accownt name change via a request to SAP Fieldglass Support Include this information: Current supplier name Mew supplier B
narme Suppler company code Effective date of the name changs. N,
SCOer
Haw can | reapen my account after clesing it7?
Reopen a closed user account Reactivate user account If you have the User Role permission User - Manage |, you can recpen a
closed buser user Bocount: Click Admin Configuration (Pear icon in 109 fight) > User Use the filters 1o locate the account Click e
Mamee to view the recond
FaQ
e
an 14 2091
How do | extend worker end date?
Contngent Worke's assagnment end date i Lited than what is noted in the system Warkes's sstignment has been extendsd Profile
worker's end date requires update Buyer users with Statement of Work - Revise permission may revise the work order to update 9
the end date for a contingent worker Locate the ¥
FAQ
olle Worke - Erasble  Wodar - Extend End D
an 16 2021
Cannot Approva Tims Sheet in ‘Pending Validatien® Status
Time Shoot status ks Pending Validation, but | cannot approwe it Pending Validation status indicates that a tme sheet ks being
validated by an extemnal appl n. Atter the time sheet i validated, iis status in SAF Fleldglass will update to Pending Appraval e
Bur Pr Manggement Office (PIMO) wil i
Yo Progs Aage Ot LR FAD
Teveshe

Help Center Home

Searching for Content in the Help Center

You can quickly access a list of applicable documents and FAQs based on your search criteria.

Context

Searching across all content will show results from our FAQs and support documentation. To search for content
in the Help Center, enter your text in the How can we help you? field and initiate your search to display the
results. The results display with a Refine menu so that you can continue narrowing your results as needed.

Welcome to SAP Fieldglass
Support Tools INTERNAL — Authorized for SAP Customers and Partners 35



Horne Learning Contact us
expense sheet . 4l
Refine 202 results for expense sheet [ Retevance - |
Type Why does user see MSP percentage during expense sheat approval?
= Users should not see MSP percentage field while approving expense sheet Expense sheet should not have MSP
[l Documentation 165 Fiee What should be entered in MSP percentage during expense sheet approval Field MSP percentage displays
G during expense sheet approval if user has permission This User can act as CoordinatorDistributor permission is 9
L] FaQ 35 needed, user can enter a fee of O percent and the fietd will not show on the approved expense sheet i the user is
== nat a coordinator, disable the ission Sign in SAP Fieldglass Click Admin Configuration
[] Support Note 2 . i ign gl n Configur AG
Experas Sheet  Uiel - Permidaion
Mo 15, 2001
Tags
— Errar: Cannot close Worker using date specified. The Worker has Time Sheet(s) or Exponse Sheot{s) that
|| Timesheet - Documenta. .. 4 &6 Ta the Actual End D
[} Timesheet - Cannt Ent... 3 The Worker has Time Sheet{s) or Expense Sheet{s) that are beyond the Actual End Date This error is recehed
o bacause the Worker End Date ks before the date of the last Time Sheet or Expense Sheet Review the transaction
L Timesheet - Edit 3 data, 1o deterrning your action For Time Sheet Locate the worker record Click Time Samp; Expense tab should be a
adjusted or the worker end date For Expense Sheet View the Time Samp; Expense tab for the worker Click 1D 1o
[[] Timesheet - Incammect H... 3 apen the Last expense sheet Determine the maxirmem date of the expenses If this date FAQ
[} Buyer Config - PMO Da... i
- Edi
[} Cost Center - Edit 2 R
] Expense Code - Missing 2
- . | do not have expense codes to create an expense sheet
[} Inveice - Creation 2
Can't create an expense sheet Thare are no expense codes 1o select Wrong expense codes Expense codes
[] Reporting - Missing Data 2 buryar and assigned to your worker by managers i you are the worker and do not have any or the comect expense
codes for expense sheet creation, contact your suparvisor If you are the supervisor or manager, you recornd: 9
[] Reporting - Set UpiCrea... 2 Locate the worker record by Name or Worker 1D Click Cost Allocation tab Click Add or Remove Expense Codes
= Filter Select the Expense codes 10 be added > Add Selected Click Update FAG
Experae Cooe - Missrg
Apr 14, 2021
How can a workar submit expenses
1 am a worker and need to submit an Expense Sheet To submit an Expense Sheet: Sign into youw SAP Fieldglass
Account Click Create > Expense Sheet Select the correct Expense Code you would like fo charge against 9
FAQ
Experas Sheet . Documentssion Requens  Buperne Code - Missing
Mar 20, 2081
Procedure

1. Use the checkboxes in the Refine menu to narrow the results or select one of the tags below the preview
text in the results list. The new results display.
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2. Toview arelated FAQ, select the question link or the FAQ (?) icon. The article displays.

KB0010960 - | need to act on a work item, but | do not see it

FAQ ATTRIBUTES LANGUAGES (10)

Symptom:

» | am not seeing My Work Items on my home page
» | am being asked to complete a work item, but | do not see any work items

Resolution:
You may still take action on the item:
1. Sign into your account
2. Click View > module name
3. From the list, locate the specific itern and click to open it
4, Click Action

Your user role permissions may affect if you can view and act on items. Contact your Program Management Office (PMO) as they
set these permissions

Attributes
Created: 28 Jan 2021
Edited: 12 Feb 2021
Categories: How to
Solution Area: Work [tems - Visibility

Languages (10)

@ English ~

Is this article helpful? | ves ‘ ‘ No |

Email

3. To change the language for the displayed article, select one from the list of available options in the
Language section.

4. To provide feedback on a topic, choose Yes or No for Is this article helpful?. A comments box will display

where you can provide additional feedback.

5. Once you're done viewing a topic, you can return to the Home tab using the back arrow (<) in the header
area.
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Browsing and Opening Support Topics in Learning

You can browse through a list of topics organized into categories to find content available in our Knowledge
Base and the SAP Help Portal.

Context

To browse through a list of available documents, select the Learning tab, then follow the steps below.

{ SAP Help Center Learning Center

Home Leaming Contact us

Documentation & Learning

This section offers product documentation, release updates, tutorials, and other resources.

Fieldglass

SAP Fieldglass Integration

> Additional Guides
> Administration
> Integration

Reference

SAP Fieldglass Mobile

> Reference

> End User Information

Help Center Learning Tab

Procedure

1. To see alist of available documents, expand a category.

2. Select the link to open a document. Product documentation opens in the SAP Help Portal
in a new tab of your browser. You can continue to browse through the documentation
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on the SAP Help Portal, or you can return to the Help Center tab in your browser.

SAP™ SAP Help Portal

SAP Fieldglass Common Data Lists

Production »

Advanced Sear

7« Common Data Lists = P -

w lists of pre-defined field values for fields in the &

US States and Territe

app
.

Canadian Provinces

e applicatior

application

United Kingdom Provinces

20 RINGOom Values 1o
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Using Guided Assistance for Support

Guided assistance is provided to help you quickly troubleshoot issues and ensure that you are directed to the
right person or team for the support you need.

Context

If we can't resolve your issues with the provided assistance, we'll provide a contact who can, or we'll guide you
through the process of creating and submitting a support case. To get started with guided assistance, select
the Contact Us tab and follow the steps below.

< SAP Help Center Contact us

Home Learning Contact us

Contact us

We're very happy to assist you. First, let us help you with recommendations made by our algorithms based on your profile, and
powered by artificial intelligence-based machine learning, to help you find an answer or point you to the right channels for support.

Start here to create a case.

How can we help you? &3

Procedure

1. Enter key words in the search box to describe the issue you need help with. Initiate the search to see a list
of recommended topics.
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2. You may be asked to refine your query by choosing an option from
some common inquiries related to your issue. Select an option, if applicable.

Contact us
We're very happy to assist you. First, let us help you with recommendations made by our algorithms based on your profile, and powered
by artificial ntelligence-based machine learning, to help you find an answer or point you to the right channels for support.

Start here to create a case.

| lost my password x Q

Browse below for our Al-based recommendations® (our support agents use them too!)

FAQ
Mar 16, 2021

I am & buyer user and | would like to reset a worker's password
Buyer would like to reset the password for a worker

My username and password are all ready populated when | try to sign in for the first time

As a new Fieldglass user, when | go to Fieldglass for the first time a usermname and password ane
automatically populating, is this my username and password? Usemame | Password already populated
when | navigate to Fleldglass. net or Fleldglass.eu My u

FAQ
Apr 12, 2021

How can | reset my password for my worker account?
Reset password for contractor account My worker username and password are not recognized | do not
Ikmonw mvy worker login details

FAQ
Feb 25, 2021

I forgot my username or password for my supplier account
Cannot access supplier account because | forgot my username Cannot access supplier account because
| forgot myy password | need to regain access to supplier account

FAD
Apr 10, 2021

FAQ
Apr 14, 2021

How Can | Reset My Password for My Buyer Account?
My username and password are not recognized Do not know my login details

@ @ ©@ ® ©

*Powered by SAP Incident Solution Matching

Answer this to help us tailor your support experience

Do you need help with one of these common worker account inquiries?

Usermnmame or Password Change Email Change Name Change Usamamo

Somathing else

3. Continue to provide information for guided assistance. Once enough information is given, you'll be
provided with steps to resolve your issue or you'll be given instructions on who to contact for support.

Results

If we are not able to resolve your issue using guided assistance, a Contact Us button will display so you can
begin creating a support case.
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Submitting a Support Case

You can easily submit a support case if you are unable to find solutions in FAQs and support documentation.

Context

The case submission form is personalized based on your user type (Buyer, Supplier, Worker, PMO). Note that
some fields will default based on your SAP Fieldglass account information and values you entered in the search
field prior to accessing the case submission form.

To create a case, select Contact Us and then follow the steps below.
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Recommendations®

En Y

We're here to help you. Please provide as much information as pessible so our
support agents can respond to you faster.

(@) Offboarding activity ltem was not sent

Requested language of support:  Englsh | Change? | @ Waming: Potential Matches Found when
Mote: If agents are unavailable to support in the language you've chosen, support submitting a candidate

will be provided with the assistance of a translation software.
How do | resend a supplier invitation?

1. Tell us what you need help with. Edit Work Order Details action is not

available on confirmed work order for
contingent

Subject:* l cancel order

Request type:* | 5 () Wnatis the difference between Work

|
|
‘ Order scope filters in reports - All, Latest,

Full description:* | Affected ifemns, expected results, efc. Latest Confirmed, Current, First?

How do | accept a Woark Order?

. —

How to update the bill rate on work order

Maodule:* [ v\l
Impacted customer: | | @ ::;:go | create a reason to reject a work
Top Recommendations: (@) Work order Start Day of Week field needs
to be updated

@ Offboarding activity item was not sent

(7) Can | update start date on a work order?
(T} Waming: Potential Matches Found when submitting a
candidate
Can you change currency on an already
e . created job posting or work order?
2. How does this impact your normal business processes?

(@) How can a supplier user modify the pay

Urgency of request:* | “ | rate on work order?
L - s How Do Remove Duplicate Rows for Work
3. Please review your contact information for correctness: ® e iy n.pm.gk

First name:* | Damon How can | update the title of a work order?

Last name:* | Dunham

Username:* | sheet?

Company:*

(2] Incorrect worker or work order Spend to

|

.| (@) How can a buyer user push a worker time
|

|

| Date values in report

Email:* | fg_gatest8@sap.com

(@ How do | extend worker end date?
Phamne: |

Confirm phone:* | | (Z) How do | create a miscellaneous invoice?

b et ) Involces are not created automatically for

contingent
[ suomi IR

A list of recommended support topics display on the right side of your screen. As you fill out the support case,
the list will update to show relevant topics.

Before beginning, you can change the language if desired.
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Procedure

The Subject defaults from the value you entered in the previous search. If necessary, change the Subject.
Select the Request Type. Available values are based on your user type.
Provide a Full Description. You can include attachments using the upload button.

Select the Module. Available values are based on your user type.

o R W

Select the Urgency of request. If you select High or Very High, you'll be prompted to provide additional
details.

o

Continue to enter your contact information and provide any optional information as needed.

Once the form is complete, select Submit and then select OK to confirm the submission.

After submitting a case, you can view it (along with other submitted cases) on the Contact Us tab. You can
also provide an update or request a follow-up. Follow-ups you provide through Help Center are listed under
the Follow-Ups tab; updates from SAP continue to be tracked only via email.

8.2 Release Communication Document

The Release Communications document contains information about new features and enhancements for the
most current release.

Release Communications are available from the Help menu along with the Feature Administration guide for
users who have the View Administrative Product Documentation feature access selected. You can also access
these documents by selecting the SAP Fieldglass Release Communication - Click here to see what's new
link that displays by default on the Home page. Selecting the link opens a new browser tab and displays

the different documents relating to the changes and enhancements associated with a release. The Release
Communications document includes both a summary of changes and expanded details for larger changes.

8.2.1 Accessing Release Communications

The Release Communication document for the current release is available on the SAP Help Portal from within
the SAP Fieldglass application.

Context

To access release communication, on the Help menu, select Release Communication. The document for the
current release opens on the SAP Help Portal in a new browser tab.
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8.3 Product Documentation Access on the SAP Help Portal

Product documentation and release communications are now available on the SAP Help Portal from within
the SAP Fieldglass application. The information available corresponds to functional roles in the system (buyer
administrator, buyer, supplier, or worker).

Documentation available covers a wide range of concepts, features, and tasks, providing you with important
information on how to configure and use SAP Fieldglass functionality. Available guides replace and
substantially improve on content previously available from Page Help and Online Help links in the application,
which have been removed in this release. You can now find this content by searching in the relevant guide on
the SAP Help Portal. Depending on your functional role in the system, different guides are available.

8.3.1 Accessing Product Documentation

SAP Fieldglass product documentation, organized into several guides, is available on the SAP Help Portal and is
accessible via the SAP Fieldglass application.

Context

To access product documentation, on the Help menu, select Product Documentation. The SAP Fieldglass
product page opens on the SAP Help Portal in a new browser tab, displaying links to guides available to your
functional role in the system.

8.3.2 Navigating the SAP Fieldglass Product Page

From the SAP Fieldglass product page, you can view individual guides, search, and provide feedback on
content.

The SAP Fieldglass product page is organized into tabs (visible if any content is available for a tab). Within each
tab, information is organized further into sections containing one or more links to individual guides. Select a
guide to open it in another browser tab.
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w SAP Help Portal SAP Fieldglass 2 Browse by Product Learning Journeys

SAP Fleldglass Cloud English ¥ Production

The SAP Fieldglass Product Page contains guides and reference materials related to configuring, managing, and using contingent labor and services procurement features
and functionality.

This product - S r a product name

Advanced Search ~-

o L Download PDFs

What's New Integrate Use [ eSSEIEM| 2 Seeall

m Administration

Find information about managing the administration of your SAP Fiel

application instance

administe

‘mation on Supplier
r functions.

SAP Help Portal Links More Links Share and follow

The SAP Fieldglass Product Page on Help Portal (with Operate Tab Selected)

Each guide includes a table of contents that you can use for quick access to individual topics. If additional
topics are available, you can select the expand arrow next to the table of contents entry. The first topic in each
guide provides information about changes to the guide since the last publication.

PDF versions of individual guides can be accessed via the Download PDF button within each guide.

If you want to return to the main SAP Fieldglass product page from within a guide, at the top of the window,
select SAP Fieldglass.

Searching

You can search using the search bar at the top of the page. Searches on the main SAP Fieldglass product page
search the entire available SAP Fieldglass documentation library, while searches performed within a specific
guide are limited to content within that guide. Advanced search capabilities provide additional precision for
locating information.
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SAP” 5AP Help Portal

SAP Fieldglass "~ cou e v

e / Creating Job Postings /

<Previous Next>

Entering Job Posting Details =

Set up your job posting and add necessary details

To create a new job posting and add job posting details:

Entering Job Posting Details

Selecting Distribution 1. Select Create > Job Posting for Worker.

Selecting Potential Candidates 2. Selecta Job Posting Owner

Viewing Job Postings Job postings are typically routed for approval based on the owner selected

3. Optionally, change the value for the Billing Currency, Service Type, and Pre-qualification Required fields

v

Managing Job Postings

Aroat PRI 4. Select the View from which to create a job posting.
Creating Named Job Postings

Creating Rebilable Recource Job 5. Select an existing job posting template or job posting

Postings
Create a Job Posting - Setup
> Flexible Sourcing Job Postings
To complete the job posting setup information
> Prequalification Job Postings

1. Enter the required fields and any optional information. Key fields are listed below.

Key Field Description

Start Date/End | The start and end dates for the job posting.
Date

Number of The number of positions required for the job posting

Positions [ —
helpful?

Title and The title and description for the job posting =

Deserntn [¥=][r]

Searching from the SAP Fieldglass Product Page and Viewing Results

Providing Feedback

At the bottom right of each topic in Help Portal guides, a small dialog asks Was this topic helpful? Once you
select your answer, you can optionally provide anonymous feedback that is sent to the guide's authors. We
highly encourage feedback to help us make content improvements for all customers.

Was this topic [l X Was this topic helpful? o x
helpful?

What is the issue?
What were you look

Providing Feedback for SAP Help Portal Topics
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8.4 Reference Library

Use the Reference Library to upload documents and other attachments in the application.

Attachments such as documents, photos, and other files can be uploaded to the Reference Library.

Upload a Document

To access the Reference Library, select the Help icon in the header bar and choose Reference Library. Once
documents have been uploaded, they display in the Reference Library list. Documents can be sorted according
to your preferences using the various filters.

1. Toupload a document, select Upload Document.

2. Enter the information for the document's Name, Description, and Category.

3. Under Visible To, select Buyer Users, Suppliers, or Workers depending on which users you would like to
have document visibility.

4. Select Browse to choose your document and select Attach.

5. Select Add. The attachment appears in the Reference Library list.

Edit or Remove a Document

* To edit an attachment from the Reference Library list, select Edit, edit the information, and choose Update.
* Toremove an attachment from the Reference Library list, select Edit, and choose Remove.
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Important Disclaimers and Legal Information

Hyperlinks

Some links are classified by an icon and/or a mouseover text. These links provide additional information.
About the icons:

®  Links with the icon o : You are entering a Web site that is not hosted by SAP. By using such links, you agree (unless expressly stated otherwise in your
agreements with SAP) to this:
®  The content of the linked-to site is not SAP documentation. You may not infer any product claims against SAP based on this information.
®  SAPdoes not agree or disagree with the content on the linked-to site, nor does SAP warrant the availability and correctness. SAP shall not be liable for any
damages caused by the use of such content unless damages have been caused by SAP's gross negligence or willful misconduct.
L]

Links with the icon ’h": You are leaving the documentation for that particular SAP product or service and are entering an SAP-hosted Web site. By using
such links, you agree that (unless expressly stated otherwise in your agreements with SAP) you may not infer any product claims against SAP based on this
information.

Videos Hosted on External Platforms

Some videos may point to third-party video hosting platforms. SAP cannot guarantee the future availability of videos stored on these platforms. Furthermore, any
advertisements or other content hosted on these platforms (for example, suggested videos or by navigating to other videos hosted on the same site), are not within
the control or responsibility of SAP.

Beta and Other Experimental Features

Experimental features are not part of the officially delivered scope that SAP guarantees for future releases. This means that experimental features may be changed by
SAP at any time for any reason without notice. Experimental features are not for productive use. You may not demonstrate, test, examine, evaluate or otherwise use
the experimental features in a live operating environment or with data that has not been sufficiently backed up.

The purpose of experimental features is to get feedback early on, allowing customers and partners to influence the future product accordingly. By providing your
feedback (e.g. in the SAP Community), you accept that intellectual property rights of the contributions or derivative works shall remain the exclusive property of SAP.

Example Code

Any software coding and/or code snippets are examples. They are not for productive use. The example code is only intended to better explain and visualize the syntax
and phrasing rules. SAP does not warrant the correctness and completeness of the example code. SAP shall not be liable for errors or damages caused by the use of
example code unless damages have been caused by SAP's gross negligence or willful misconduct.

Bias-Free Language

SAP supports a culture of diversity and inclusion. Whenever possible, we use unbiased language in our documentation to refer to people of all cultures, ethnicities,
genders, and abilities.
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/contactsap

© 2023 SAP SE or an SAP affiliate company. All rights reserved.

No part of this publication may be reproduced or transmitted in any form
or for any purpose without the express permission of SAP SE or an SAP
affiliate company. The information contained herein may be changed
without prior notice.

Some software products marketed by SAP SE and its distributors
contain proprietary software components of other software vendors.
National product specifications may vary.

These materials are provided by SAP SE or an SAP affiliate company for
informational purposes only, without representation or warranty of any
kind, and SAP or its affiliated companies shall not be liable for errors or
omissions with respect to the materials. The only warranties for SAP or
SAP affiliate company products and services are those that are set forth
in the express warranty statements accompanying such products and
services, if any. Nothing herein should be construed as constituting an
additional warranty.

SAP and other SAP products and services mentioned herein as well as
their respective logos are trademarks or registered trademarks of SAP
SE (or an SAP affiliate company) in Germany and other countries. All
other product and service names mentioned are the trademarks of their
respective companies.

Please see https://www.sap.com/about/legal/trademark.html for
additional trademark information and notices.

THE BEST RUN


https://www.sap.com/about/legal/trademark.html

	Welcome to SAP Fieldglass
	Content
	1 Getting Started
	1.1 What's New in This Guide
	1.2 Your SAP Fieldglass Home Page
	1.2.1 My Workers Dashboard
	1.2.2 My Statements of Work Dashboard
	1.2.3 My Job Postings Dashboard
	1.2.4 Customizing Your Home Page

	1.3 Settings
	1.3.1 My Profile
	Proxy
	Delegate

	1.3.2 My Preferences
	1.3.3 My Org Chart
	Organizational Chart
	Viewing the Organizational Chart



	2 Working with SAP Fieldglass
	2.1 Feature Switch
	2.2 Navigation
	2.3 Search Tools
	2.3.1 Global Search
	2.3.2 Search People
	2.3.3 Find Similar People

	2.4 Working with List Views
	2.4.1 Past & Archive Data
	2.4.2 View Workflow


	3 Pinning Links
	4 Social Messages
	4.1 Annotations
	4.2 Chat
	4.3 Reminders
	4.4 Social Messages Management Tools

	5 Starring
	6 Ask an Expert
	7 PMO Dashboard
	7.1 Thresholds - PMO Dashboard
	7.2 Using the PMO Dashboard

	8 Support Tools
	8.1 Customer Support Help Center for SAP Fieldglass
	8.2 Release Communication Document
	8.2.1 Accessing Release Communications

	8.3 Product Documentation Access on the SAP Help Portal
	8.3.1 Accessing Product Documentation
	8.3.2 Navigating the SAP Fieldglass Product Page

	8.4 Reference Library

	Important Disclaimers and Legal Information
	Copyright / Legal Notice


